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SCRIPT FORMATTING 101 
 
Why does this document exist?  
 

Simply put, many new writers have trouble formatting their script for a play or musical, and I 

thought I’d put in my two cents as a professional producer. There are some industry standards, 

but by and large, people have either been following submission guidelines from the Dramatists 

Guild or Samuel French that have been widely shared across the Internet and held (arbitrarily, I 

feel) to be the standard, replicating templates by other licensing houses, or just writing it and 

worrying about formatting later. 

 

One may find templates to use in garden-variety screenwriting software such as Final Draft, and 

they’re welcome to use those as they like. However, I tend to find such programs confusing to 

operate, especially with all the keystroke commands, and they never come out looking quite like 

I want them to. Generally, I want them to look like the scripts I’ve seen in the past; while the 

screenplay templates of such programs at least look like a standard film script, however 

technically perfect their stage script template is about meeting its preset standard, it just never 

looks “right,” know what I mean? Besides this, every licensing agency soliciting submissions 

will say that if you use screenwriting software, its default settings are not necessarily standard 

play format. Moreover, if one doesn’t have such programs, they’re dealing with Microsoft Word 

or a similar word processor, which is not equipped to deal with the demands of a play or musical 

unless one creates a new template. 

 

So… I’ve come up with my own set of general rules that has always served me well, plucking a 

little here and there from each format I’ve encountered, and one is welcome to give them a shot! 

For the record, nobody is married to this. It’s just a pointer for those who have no clue. I always 

re-format the scripts created by my office this way, mainly because I want to set an example, and 

it’s what I have arrived at after years of trial and error. 

 

Before we begin… 
 

All references to function apply to Microsoft Word 2021. Some research may be required for 

your particular word processor. Also, all measurement references are in imperial units. Attempts 

at metric conversion throughout failed due to an inability to determine the default metric unit 

Word uses internationally. My apologies. 
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SCRIPT FORMATTING 101 
 
Page Margins (for Printing and Binding Purposes) 
 

You should set custom margins for your script like so: 

 

• Select the Layout tab in the ribbon. 

• Select the Margins button on the far left-hand side. 

• When the drop-down menu opens, choose Custom Margins… at the bottom of the list. 

• When the “Page Setup” window opens, leave every other field alone, but set “Left” to 

1.5” (one-and-a-half inches) to allow extra space for binding when printed. (This goes 

back to the days of printing out the script, adding special “cover page” paper, and 

binding it with brass brads. Today, it leaves enough space not to screw up hole-punching 

for whatever binding you choose, particularly traditional or three-ring binding.) 

• Additional tip: The above presupposes a single-sided page script, like the good old days. 

If you are printing on both sides of a page, like an MTI libretto/vocal book or the spiral-

bound materials R&H used to distribute, doing the above will leave you with extra white 

space in the wrong margin, and binding may interfere with the body of your script on the 

back side of each page. To avoid this, select Mirror margins in the same window, in the 

drop-down menu next to “Multiple pages.” This is a unique setting designed especially 

for a two-sided layout that allows you to mirror the margins of a page depending on 

whether it is odd or even. That way, your binding will always be in the white space. 
 

Font 
 

Script formatting hit its prime in the age of the typewriter; while tools have changed with the 

advent of computers, PDF, and printers, standardizing around a specific typeface and size has 

been the case for so long and is so woven into the fabric of the industry that it’s just what we do. 

 

12-point Courier (New or otherwise) used to be the standard, mainly because it was the standard 

typeface on IBM’s best-selling Selectric II typewriter, and soon became the default typeface. 

However, the standard has grown lax with time. Most submission guidelines say that as long as 

it’s a readable font (for example, 11- or 12-point Times New Roman), they don’t care. Indeed, 

many modern scripts are set in Times New Roman. It’s such a ubiquitous font that you might not 

even notice it. It is installed on all Mac and Windows operating systems and was the default font 

for Microsoft Word for many years. It’s serviceable, but there are two main reasons, among 

others, to choose another font in its place. The first reason is purely aesthetic: replacing Times 

New Roman with something less pedestrian can make your script look more distinctive. The 

second reason is more practical: Times New Roman can be difficult to read, especially at smaller 

point sizes. 

 

If you’re working on a script that has been carefully set with Times New Roman and is already in 

its final stages, your options are more limited if you want to avoid “items shifting during flight.”  
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SCRIPT FORMATTING 101 
 
Font (cont.) 
 

One option—available at no cost from Google Fonts under the Apache 2.0 license—is the Tinos 

font (formerly Liberation Serif), designed by Steve Matteson as a metrically equivalent font to 

Times New Roman. That means that you can replace Times New Roman with Tinos, and the 

position of your text will stay the same. The latter is generally more legible than the former, 

definitely more square and less decorative, and, to be clear, that’s the point. Tinos is not trying to 

be a close replica of Times New Roman; its main feature is that it fits precisely into the same 

space as TNR. Hopefully, it looks appropriately distinctive, as I’ve set the entire document so far, 

barring the company letterhead, in Tinos to get you comfortable using it. 

 

As for the size, it’s always better to go with 12+ because most readers’ eyesight fades as they 

age, usually quicker than they’re willing to admit. (This text is 12-point, just for a frame of 

reference.) 

 

Pagination and You: A Guide to Headers and Section Breaks  
 

Scripts require different page number formats in separate sections. Formal page numbering 

begins with the actual first page of the play; Page 1 should never appear beforehand. The title 

page is not numbered and never should be. Any necessities before the start of the script proper 

(i.e., character or song/scene lists, etc.) are usually numbered with Roman numerals (e.g., I, II, 

III, etc.). The pagination for the play itself should be continuous and not reset at the start of an 

act or scene; speaking of which, acts/scenes should also be in the page number. (Example: if Act 

II, Scene 5 occurs on page 61, it should look like this: II-5-61. In the event of a prologue in either 

act, go with 0 for the scene number; it occurs before the first formal scene either way.) Lastly, all 

page numbers should appear in the top right corner, right-aligned. 

 

That’s a lot to keep track of, right? In the old days, they had to do it the hard way: manually 

typing the numbering for each page and right-aligning it. But there’s an easier method if you 

allow Word to do the legwork for you. I mean, you still have to do some stuff, but not all. 

 

First, a quick refresher on page numbering is in order: 

 

• Select the Insert tab in the ribbon. 

• In the seventh subsection from the right, Header & Footer, select the Page Number 

option. 

• In the resulting pop-out menu where you choose where you want the page number to be, 

select Top of Page, and then Plain Number 3 in the following pop-out menu, which will 

automatically set a right-aligned page number in the top right corner of your document. 

• This will also automatically open up the Header & Footer Tools ribbon, specifically the 

Design subsection. Put a tick in the box next to Different First Page, and just like that, 

you’ve excluded the title page from numbering! Look at you go! 

https://fonts.google.com/specimen/Tinos
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SCRIPT FORMATTING 101 
 
Pagination and You (cont.) 
 

• Don’t forget to alter the pagination to match the overall look of your document. If your 

document’s main font is 12-point Tinos, for example, the page numbers should be, too. 

Highlight the number that has now landed there and adjust the size and font accordingly. 

• Next, right-click the page number itself. In the resulting drop-down menu, select the 

Format Page Numbers option. 

• A window should open up labeled Page Number Format. In the drop-down list next to 

Number format, you can switch to any of several variations in the page numbering, such 

as an Arabic numeral (i.e., 1, 2, 3, etc.) with or without a dash on either side, a lowercase 

Roman numeral, an uppercase Roman numeral, etc. Choose whatever is appropriate to 

the section you’re working on. 

• Note that pagination is constant, meaning you can add anything in front of the 

(automated) page number, and it’ll stay in sync with the rest of the document, or at least 

with whatever parameters you give the numbering. This is how you’ll pull off, for 

example, II-5-61 (and the page numbers that follow) later. 

• Once you’re done with this and out of the header, feel free to use Page Break on the 

Insert tab as necessary in the document’s main body to force items onto the next page. 

(An example will come within the script template to follow.) 

 

“Alright,” you may be saying. “I’m all set for the first section. Big whoop! What about varying 

the numbering throughout the document in all the other sections?” Keep your shirt on, I was just 

getting to that! Word recognizes that large documents occasionally require different page number 

formats in separate sections, and they provide a handy tool to help you accomplish that. 

 

So, let’s assume you’ve finished the character list, the scenes and/or musical numbers, and 

everything that comes before the script begins, and you’ve been using the Roman numerals all 

the way through. Here’s what happens next: 

 

• Select the Layout tab in the ribbon, which should be familiar from setting the margins 

earlier. 

• This time, select Breaks in the same subsection where you found the Margins button. 

• A menu will pop out with a list of possible Page Breaks and Section Breaks. In this 

case, under Section Breaks, choose Next Page, which Word handily explains will “insert 

a section break and start a new section on the next page.” 

• You’ll notice that the page numbering has restarted at the beginning, indicating you’ve 

successfully started a new section. Double-click in the header to open it for editing, 

which should also open up the Design tab of Header & Footer Tools. 

• You’ll notice a little label at the bottom right of the header that says “Same as Previous.” 

This is what you want to avoid. Move up to the Design tab, and un-tick the box next to 

Link to Previous. You have now started a new header in a new section! 
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SCRIPT FORMATTING 101 
 
Pagination and You (cont.) 
 

• Using the Format Page Numbers function described above, you can switch to Arabic 

numerals (i.e., 1, 2, 3, etc.) and select Start at ___ and fill in 1. Congratulations, you’re 

on Page 1—don’t forget to stick an act and scene designation in front of it (e.g., I-1-1). 

• When you move on to the next scene, repeat the first five bullet points to change the act 

and scene designation; once you’ve set the header the first time, they’re all you’ll ever 

need to manually change for each section. As for the page number, to keep it continuous 

in the script proper after Scene 1, use the Format Page Numbers function to set the 

numbering to continue from the previous section. “Set it and forget it!” 

 

Now that the basic guidelines are in place, it’s time to get more specific about each element. In 

the following section, I’ll first show you a sample, and then break down the more granular points 

on the page that follows. Sort of a style guide, if you will. 



 

Data (Draft No., Desc., etc.) 

(Date) 

 

 

 

 

 

 

 

TITLE 
_______________________ 

 

Byline (A Musical, A Play, etc.) 
 

 

Primary Credit by Name (repeat as needed) 
 

 

Secondary Credit (if any) by Name (repeat as needed) 
 

 

Source Material or Tertiary Credit by Name (repeat as needed) 

 

 

 

 

WGA Reg. No. (if applicable) 

Copyright Info 

 

Contact Info 
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SCRIPT FORMATTING 101 
 
Title Page 
 

The preceding is what a title page should look like, complete with the margins I described at the 

beginning of this tutorial (as, indeed, all of the samples will have). It is not numbered (and, 

again, never should be), and it contains all the essential information (title, byline, credits, 

copyright notice, etc.). 

 

• In the upper right corner, right-aligned, is the data relevant to this particular edition of the 

script, such as the draft number, what type of script it is (e.g., “Workshop Draft,” etc.), 

and the date it was completed. This is primarily helpful for filing and archival purposes, 

but it also helps ensure you’re sending the right draft to the right person at the right time. 

 

• The title and byline should be centered approximately halfway down the page. (In Word, 

this is typically at the two-inch mark on the vertical ruler to the left-hand side. Of course, 

it would help to be able to see the ruler, which is turned off by default; to turn it on, 

choose the View tab and tick the box next to Ruler in the fourth subsection from the left.) 

 

• The title is always 24-point and bold and is separated from the byline by a manually 

typed underline, achieved by switching to 12-point, turning off bold, and hitting the 

underscore key approximately twenty-three times. 

 

• The byline and credits are all separated by two 12-point line breaks between each. The 

byline is always 14-point, the primary credit is always 16-point, then the secondary credit 

(if any) is 14-point, and any tertiary (e.g., Orchestrations or Dramaturgy credit if 

mandated, etc.) or source material (e.g., if the musical or play is based on a popular film 

or novel) credit, if applicable, is 12-point. The names of each person credited should be 

bold, in the size of their respective line, and mixed case (i.e., both upper and lowercase, 

as in John Smith). 

 

• After the credits/billing are finished, there are four 12-point line breaks (or however much 

space allows), followed by the WGA registration number (if applicable), copyright 

notice, contact info (if you have an agent, put theirs; otherwise, put yours), etc. 

 

• The WGA number (again, if applicable) and copyright notice should be separated from 

the contact info by a single line break (if space allows), and all of that information should 

be right-aligned at the bottom of the page. 



I 

 

SHOW TITLE 

 

CAST OF CHARACTERS 

 

(In Order of Appearance) 

 

 

LEADS: Brief description (age/vocal range, character details, etc.). 

SUPPORTING: Brief description (age/vocal range, character details, etc.). 

ENSEMBLE: Describe, in brief, the various groups that members of the 

chorus – if there is one – may play. 

  

 

 

ADDITIONAL NOTE(S) 

 

Any additional notes on casting (possible doubling, enlarging/reducing cast size, etc.) go 

here. 
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SCRIPT FORMATTING 101 
 
Cast of Characters 
 

As it says on the tin, this is a brief listing of the cast of characters (i.e., names, ages, genders, any 

short but important physical characteristics or other form of description, vocal range if 

applicable, possible doubling in casting, etc.). 

 

• The page should always immediately follow the title page and always begin with the 

show’s title, the “CAST OF CHARACTERS” heading, and the notation “(In Order of 

Appearance).” The first two are underlined, and the last is italicized. They are separated 

from one another by a single 12-point line break. 

 

• There are two 12-point line breaks after “(In Order of Appearance)” before the list 

begins. 

 

• The list’s look is achieved by creating a table with two columns, set to “No Border” for a 

polished look. For tidiness’ sake, before flipping the switch (so you can see what you’re 

doing), you may expand or contract the borders of individual cells as necessary, so long 

as the final result is clean and readable and doesn’t run into the binding, as in the sample. 

You will also center-align the finished table (not its contents!). 

 

• The characters’ names in the left-hand column are always bold and uppercase, followed 

by a colon. They are listed in order of appearance in each category (i.e., Leads first, then 

Supporting, etc.). 

 

• In the event of a smaller cast or a show without an ensemble, you might opt to add an 

empty row between each character, the better to fill the page. 

 

• You may also need to add an extra row at the end of the character list (which no one will 

see anyway), as in the sample, so the bottoms of the letters aren’t cut off, as occasionally 

happens with Tinos. 

 

• The number of 12-point line breaks before the additional note(s), if there are any, is two if 

there’s an invisible extra row, and three if not. The heading is always centered, 

underlined, and separated from the left-aligned note(s) by a single 12-point line break. 



II 

 

SHOW TITLE 

 

SYNOPSIS OF SCENES AND MUSICAL NUMBERS 

 

TIME: Description of period. 

PLACE: Description of place. 

  

 

ACT ONE 

 

 Overture (if there is one) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  Instrumental 

 

Scene One: Brief Description of Setting 

 “Song Title” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Soloist 1, Soloist 2, Company 

 

ACT TWO 

 

 Entr’acte (if there is one) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Instrumental 

 

Scene One: Brief Description of Setting 

 “Song Title” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Soloist 1, Soloist 2, Company 
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SCRIPT FORMATTING 101 
 
Synopsis of Scenes and Musical Numbers 
 

Again, pretty self-explanatory. A listing of scenes and musical numbers is important. The latter 

should include both the song titles and the characters who sing them. 

 

• The page should always immediately follow the cast of characters and always begin with 

the show’s title and the “SYNOPSIS OF SCENES AND MUSICAL NUMBERS” 

heading. Both are underlined, and they are separated from one another by a single 12-

point line break. 

• There are two 12-point line breaks before the time and place indications. 

• The indications’ look is achieved by creating a table with two columns, set to “No 

Border” for a polished look. For tidiness’ sake, before flipping the switch (so you can see 

what you’re doing), you may expand or contract the borders of individual cells as 

necessary, so long as the final result is clean and readable and doesn’t run into the 

binding, as in the sample. You will also center-align the finished table (not its contents!). 

• You may need to add an extra row at the end of the above (which no one will see 

anyway), as in the sample, so the bottoms of the letters aren’t cut off, as occasionally 

happens with Tinos. 

• The number of 12-point line breaks before the scene/song list is one if there’s an invisible 

extra row, and two if not. There is one between each act following each list. 

• Each scene in the list is left-aligned, bold, and not indented/tabbed; each musical number 

is indented/tabbed once. 

• All titles of instrumental sequences appear sans quotation marks. (I almost suggested 

leaving the indication of an “Instrumental” up to you, but I’ve never lost a dollar 

underestimating a reader’s intelligence. You may substitute “Orchestra” if you like, but 

an indication is recommended regardless of the terminology.) 

• All soloists are listed in the order in which they appear in the musical number. 

• You may substitute “Ensemble” for “Company,” or even a more specific designation than 

either, but keeping it generic allows for flexibility in revision. 

• In my experience, as spaced in the sample, each act can fill up to a single page, if not 

longer (depending on how thorough you are in listing, say, underscoring). You may try 

eliminating line breaks between scenes and musical numbers to save space, but that’s not 

always a guarantee. 

• Ellipses between the musical number and the list of performers are always like so: “. . .” 

After setting the initial three, copy-paste as necessary until the list is pushed to the right 

margin. Ideally, the list will take up a single line; if not, three characters per line is my 

recommendation for tidiness’ sake. You may occasionally discover that the list will only 

stay on a single line if there is a period next to the first soloist with no space. This will 

not do; eliminate that period and put an extra space in its stead (see “Overture” in the 

example). It should maintain neatness and keep the list, or its start, on a single line. 



III 

 
SHOW TITLE 

 

SYNOPSIS OF SCENES [Straight Play]  

 

 

If there is a unit set or a single scene: 

 

TIME: Description of period. 

PLACE: Description of place. 

  

If there’s more than one scene: 

 

Scene One: Brief Description of Setting 

Scene Two: Brief Description of Setting 

 

If there’s more than one act: 

 

ACT ONE 

 

 Scene One: Brief Description of Setting 

 Scene Two: Brief Description of Setting 

 

ACT TWO 

 

 Scene One: Brief Description of Setting 

 Scene Two: Brief Description of Setting 
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SCRIPT FORMATTING 101 
 

Synopsis of Scenes (Straight Play) 
 

Similar to the last one, but different. Let’s dive right into it. 

 

• The page should always immediately follow the cast of characters and always begin with 

the show’s title and the “SYNOPSIS OF SCENES” heading (the “Straight Play” 

indication is not necessary and only appears here to distinguish it from the musical 

sample). Both are underlined, and they are separated from one another by a single 12-

point line break. 

 

• There are two 12-point line breaks before the time and place indications. 

 

• The indications’ look is achieved by creating a table with two columns, set to “No 

Border” for a polished look. For tidiness’ sake, before flipping the switch (so you can see 

what you’re doing), you may expand or contract the borders of individual cells as 

necessary, so long as the final result is clean and readable and doesn’t run into the 

binding, as in the sample. You will also center-align the finished table (not its contents!). 

 

• You may need to add an extra row at the end of the above (which no one will see 

anyway), as in the sample, so the bottoms of the letters aren’t cut off, as occasionally 

happens with Tinos. 

 

• Everything else is as seen in the sample, and—in the event of more than one act—follows 

the spacing conventions of the previous musical-centric variant, with the scenes 

indented/tabbed once rather than musical numbers. 

 

• If there is more than one scene and space allows (usually only in the event of a one-act), 

you may include a line break between each scene. 

 

• When not dealing with a song list as seen before, this information is usually short 

enough, especially if a unit set or single scene is indicated, to include on the same page as 

the “CAST OF CHARACTERS” to save space and hasten the reader along to the actual 

text. (In that event, it should follow the character list.) However, you may opt to stick the 

information on a separate discrete page regardless to avoid confusion. Either is fine. 



I-1-1 
 

ACT I 

Scene 1 

 

(Description and action look like this. They consist of what the 

audience sees the characters doing, sometimes with an indication 

as to their motivation. Description and action should be simple, 

active, specific, evocative, and visual. It should suggest movement. 

Use verbs and nouns that create visual, sensory, and auditory 

images. Use economy of language, the goal being ease of reading.) 

 

CHARACTER NAME 

 

(Parenthetical follows the same conventions as descriptions; unlike 

this example, you should only use it to change the direction to 

whom the speaker is addressing, to reveal a change in voice, or to 

direct actors, but the last with no more than simple one-line cues) 

 

Dialogue looks like this. For emphasis, underline the word you wish to emphasize. 

 

 
 

 THE LYRICS TO A SONG 

 APPEAR IN ALL CAPS 

 AND ARE INDENTED/TABBED ONCE. 

 IF THE SAME CHARACTER 

 WHO WAS JUST SPEAKING 

 IS NOW SINGING, 

 THEIR NAME DOES NOT NEED 

 TO APPEAR ABOVE THE LYRICS. 

 

 THE ONLY EXCEPTION IS 

 IF THE SONG IS STARTING 

 ON ANOTHER PAGE, 

 IN WHICH CASE 

 INCLUDE THE CHARACTER’S NAME 

 (POSSIBLY WITH “(CONT.)” NEXT TO IT 

 IF THEY WERE STILL SPEAKING 

 AND CONTINUE INTO SONG). 

 OTHERWISE, NAME THE SOLOIST FIRST! 

 

(Enter ANOTHER CHARACTER. Character names are always 

uppercase in stage directions.) 

  

Music Cue #1 – A Song 



I-1-2 
 

ANOTHER CHARACTER 

 

That has to be the weakest goddamn song I’ve ever heard. And I’m going to make a big 

speech about how shitty it was because this is my template and I can do what I want. It 

doesn’t sing. There’s not a scintilla of rhythm to be found. And the rhymes… where in 

blue fuck are the rhymes?  

 

CHARACTER NAME 

 

Hey, just a minute— 

 

ANOTHER CHARACTER 

 

—and this is how you cut someone off. 

 

CHARACTER NAME 

 

Oh, I get it now, you’re describing how… 

 

ANOTHER CHARACTER 

 

Yeah, and that’s how you show someone is trailing off. 

 

CHARACTER NAME 

 

What if we both talk at once? That must 

be hard to demonstrate. Then again, 

maybe not… 

ANOTHER CHARACTER 

 

Well, simultaneous dialogue is placed 

side-by-side, ideally spaced to start and 

end at the same place on the page. 

 

CHARACTER NAME 

 

That table tool and the ability to change cell size and switch off borders come in handy 

here, I take it. 

 

ANOTHER CHARACTER 

 

You bet your ass. Now, it’s time for a big dramatic monologue. If you, the reader, assume 

it has a purpose other than being a pointless rant that has zilch to do with the price of tea 

in China, you’re 100% on the money! Let’s say a speech continues onto the next page, as 

any paragraph would. A sentence runs on and could go on without any clue who’s saying 

what, as though unencumbered by formatting conventions. The character is running off at 

the mouth like Lucky in Waiting for Godot. (You know the scene.) Do you want that? Of 

course not. So, here’s what you do there. After the last complete sentence on the previous 

page, you hit enter. That should put the remainder of the speech on the next page. (If it 

doesn’t, insert a page break. Sometimes you gotta crack a few eggs to make an omelet.) 

  



I-1-3 
 

ANOTHER CHARACTER (CONT.) 

 

Then, you simply add a designation indicating that the character is continuing to speak as 

you see above before the dialogue (or the song, it applies either way) continues. Got it? 

 

CHARACTER NAME 

 

I think they do. 

 

ANOTHER CHARACTER 

 

Good, ‘cause unless you write like Shakespeare, it’s hard to fill a page with talking. 

 

CHARACTER NAME 

 

Ain’t that the fuckin’ truth! 

 

(Well, if that’s the end of the scene, there’s nothing more to do. The 

close of a scene should be appropriately noted in every instance 

[i.e., “Blackout,” “Scene Change,” “Curtain,” etc.], and should 

appear in uppercase, aligned and rendered as per stage directions. 

If it’s the end of the first act, however, you throw in a couple of line 

breaks and then…) 

 

 

END OF ACT I 
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The Play Proper 
 

Ideally, the sample covered just about everything, but here are the extra details. 

 

• Each new act and/or scene starts on a new page, center-aligned. The act designation is 

uppercase, Roman numerals, and underlined, the scene in mixed case, Arabic numerals, 

and underlined. A single 12-point line break separates the opening description from these. 

• When a moment is too short to be formatted as a separate scene, like a brief transition 

from one scene to the next which contains significant dramatic action but could be 

described in the space of a paragraph, you label it “TRANSITION:” at the start and 

render it as you would a conventional stage direction after the scene proper has ended. 

• The scene proper begins with a description of the setting and activity at the beginning of 

each scene. Some open their description with the terms “Setting” or “At Rise,” but I think 

the formatting itself suggests the former well enough, while the latter confines scenic 

transitions to the rise and fall of a curtain – more common in a bygone era than today’s 

theater of folding sets and computerized light displays. In any case, write it left-aligned, 

highlight it, and use Word’s horizontal ruler to slide it to the 1.5-inch mark. (Why not just 

hit “Tab” until you’re in roughly the right place? First, note the word “roughly”; second, 

if it’s longer than one line, it continues into standard alignment on the next line. When 

you drag the direction to the 1.5-inch mark, the text wraps accordingly.) 

• Any stage directions, including the initial description, should always appear in standard 

parentheticals, rendered in italic. 

• When a character speaks or sings, their name should be centered, uppercase, and bold, on 

a line by itself. (If continuing a speech or song from a previous page, include “(CONT.)” 

after their name on the same line before continuing.) 

• Any stage direction specifically associated with a character (e.g., a parenthetical) or 

occurring while the character is saying/singing something and followed by more 

dialogue/singing is separated from the character’s name and the dialogue or lyric by a 

single 12-point line break in each direction between the action and the spoken or sung 

material. 

• The titles of musical numbers, song or instrumental, should always be rendered bold and 

italic and left-aligned, white in color, on a horizontal black bar. The format is: “Music 

Cue #[Number]: Title,” in mixed case, with “Number” being the song’s numerical 

position in the score, and any additional information separated from the song title by a 

dash, as in the event of a reprise. The black bar is created by going to the Insert tab on 

the ribbon, choosing Shapes, and selecting the first item to the left under Rectangles. 

Draw a rectangle with your cursor across the page, and to achieve the proper black color, 

choose the equivalent example farthest to the left in the “Shape Styles” section. Then 

right-click it and choose Wrap Text from the menu. In the resulting pop-out submenu, 

select Behind Text. This will place the black bar behind your text. Set the color, 

thickness, etc., of your font accordingly, and then adjust the size of the black bar so it 

doesn’t overwhelm the rest of the page. (Top tip: after you’ve done it once, you can copy-

paste it everywhere else it will need to appear in the script.) 



h u n t e r   a r r o g a n t 

e n t e r t a i n m e n t 
 

SCRIPT FORMATTING 101 
 

The Play Proper (Cont.) 
 

• If a new character starts a song rather than the person who spoke last, a single line break 

in either direction separates the character’s name from the title and the lyrics. 

• Song lyrics should be uppercase, indented/tabbed once. (As with the stage direction, to 

avoid having to do that for every line, type out the verse in uppercase in standard left-

aligned format, highlight it, and drag the section using Word’s horizontal ruler to the 

halfway notch before the 1-inch mark.) 

• Spacing between characters’ sections of a song, and trailing off vs. cutting off, follows 

the equivalent dialogue rule. Simultaneous lyrics follow the equivalent simultaneous 

dialogue rule, with a similar manual indent/tab to the standard lyrics and line breaks that 

follow as much as possible what word, phrase, or (sometimes) syllable is being sung at 

the same time per the score. 

• The close of the show follows the convention set in the sample, with one difference: after 

the last transition or close of a scene, add a couple of line breaks, and write “CURTAIN,” 

followed by “END OF PLAY,” both of which should appear in uppercase, center-aligned 

and underlined, with a single line break between them. 

 

Conclusion 
 

This has been your guide to a clean, readable script, the Hunter Arrogant way. Happy formatting! 


